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Synfig es un proyecto de software libre multiplataforma para animaciéon en 2D. La
aplicacion con la que vas a trabajar, Synfig Studio, proporciona una interfaz grafica para
crear y manipular animaciones de ese tipo. La direccién del correspondiente sitio web es
http://www.synfig.org/. Alli puedes descargar el programa, consultar documentacion
y participar en sus foros.

Durante la redaccion de este documento, de verano de 2015 a enero de 2016, el software
alcanzo su version 1.0.2, que todavia tiene algunas limitaciones resefiables, como la im-
posibilidad de incorporar interactividad a nuestras animaciones y graves deficiencias en
la adicién de sonido. La creacion de animaciones interactivas es algo que ni siquiera tra-
taremos, pero la incorporacion de sonido si vamos a abordarla utilizando una aplicacion
distinta, Avidemux (también de software libre y multiplataforma).

El objetivo de este documento es que acabes siendo capaz de manejar las herramientas
necesarias para crear pequenas animaciones que incluyan movimientos, cambios de for-
ma, texto y musica de fondo. Primero practicaras con ejercicios independientes y muy
guiados; finalmente, se te planteara como ejercicio final un reto en el que tendras que
poner en practica todo lo aprendido con anterioridad.

Los siguientes ejercicios incluyen muchas explicaciones y estan pensados para facilitar
tu aprendizaje. Por lo tanto, no te centres tinicamente en seguir los pasos que se te
pida dar, sino también en intentar entender qué se pretende conseguir con ellos. Mas
adelante, al final de este documento, se te va a plantear un problema que tendras que
resolver por ti mismo, es decir, sin que te digamos los pasos que deberias dar para
obtener el resultado perseguido.

Para poder llevar a cabo todos los ejercicios, necesitas contar con los siguientes ficheros:
simple.sif, nave.png, trayectoria.sif, monteverdi.mp3, EduardMarcSpace.mp3,
modelo.flv y cochefl.png. Todos estos ficheros puedes encontrarlos en el paquete
Ficheros.zip disponible en http://www3.uji.es/~fprat/synfig/intro/.

El objetivo de este ejercicio es tener una primera toma de contacto con Synfig Studio y
explorar un documento previamente creado que contiene unos pocos elementos visuales
estaticos, sin ninguna animacién. También nos familiarizaremos con los conceptos de
capa y parametro y comprobaremos que los documentos Synfig pueden guardarse en
ficheros legibles (je incluso modificables!) con cualquier programa de edicién de textos.

Arranca Synfig Studio y observa que se ha creado una animacién vacia llamada
Synfig Animation 1. Eliminala haciendo uso de la equis junto a su nombre.



http://www.synfig.org/
http://www.avidemux.org/
http://www3.uji.es/~fprat/synfig/intro/
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2 Utiliza File » Open para abrir simple.sif. Observaras algo parecido a lo que se
muestra a continuacion:
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Aprovechemos para presentar los principales elementos de la ventana de Synfig
Studio: en el centro, la ventana del lienzo (canvas); a su izquierda, la caja de
herramientas (toolbox); en las zonas derecha e inferior, diferentes contenedores de
paneles (dock dialogs).

3 Fijate en el panel Layers que se muestra en el contenedor inferior derecho. Com-
parte contenedor con otro panel, Sets, que no se muestra actualmente (ya que la
pestana que estd seleccionada es la de Layers) y del que no vamos a hacer ningtin
uso. El panel Layers si nos resultara 1til, puesto que nos muestra las diferentes
capas del lienzo y el concepto de capa es fundamental en Synfig: sirve para repre-
sentar elementos gréaficos (como circulos, cuadrados o tridngulos), pero también
para muchas otras cosas (como representar traslaciones y rotaciones o, simple-
mente, agrupar otras capas). Por ejemplo, la capa Sol es solamente un circulo,
pero la capa Casa agrupa otras dos capas. Averigua qué elemento de Layers has
de pulsar para que se despliegue el contenido de Casa. .. y prlsalo.

4 Observa que, si dejas el cursor encima de la pestana de un panel, se te muestra
su nombre y aprovéchalo para buscar el panel Parameters. Una vez encontrado,
asegurate de que es el panel que se muestra en su correspondiente contenedor y
haz este contenedor algo mas grande, tanto en horizontal como en vertical.

5 Ve seleccionando con el ratéon las diferentes capas del panel Layers y observa qué
efecto tiene esto tanto en el lienzo como en Parameters. Detente en la capa Tejado
y observa en Parameters los diferentes parametros de esa capa: sus nombres y
sus valores. Los hay de diferentes tipos: nimeros reales y enteros, valores binarios
(bool), vectores 2D y colores, entre otros. Despliega el pardametro Vertices List.
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Haz doble clic en el valor del tercer elemento de esa lista de vértices y observa
que ahora puedes teclear el valor que quieras. En concreto, introduce 100 como
segundo elemento del par y observa qué le sucede al tejado. Estas modificando un
parametro de una capa desde el panel Parameters.

Ahora vas a mover el tejado utilizando sus tiradores (handles), que son unos puntos
que se muestran en el lienzo asociados a la capa seleccionada y que permiten,
mediante su arrastre, modificar parametros asociados. Observa el tirador verde,
en el centro de la base del triangulo:

Arréastralo a otra posicion y observa sus efectos sobre el propio lienzo y en el valor
del pardmetro Origin en Parameters.

Deshaz el cambio de posicion del tejado utilizando la combinacién de teclas
Ctrl+Z.

Selecciona Casa en Layers y observa que tiene parametros y tiradores distintos de
los que viste en Tejado, que es una capa poligono, mientras que Casa es una capa
grupo. Explora diferentes posibilidades para modificar los parametros de la capa,
deshaciendo los cambios después de cada prueba. Finalmente, utiliza el tirador
adecuado para hacer la casa mas grande en su conjunto mediante un escalado
igual en anchura y altura.

Guarda este documento con la casa mas grande como simple2.sif (con File »
Save As...) y sal de Synfig Studio.

Abre simple2.sif con cualquier editor de texto, busca la secuencia de digitos 466
y fijate en el nimero que aparece entre <g> y </g> en la linea de arriba: ahora
es un uno. Cambialo para que sea un ntmero real entre cero y uno mas cerca de
cero que de uno, teniendo en cuenta que el separador de decimales ha de ser un
punto, no una coma (por ejemplo, puedes dejar la linea como <g>0.3</g>).

Guarda simple2.sif, sal del editor de texto y abre el fichero con Synfig Studio.
., Qué cambio evidente puedes detectar observando el lienzo?

Cambia ahora algun color (de sol, tejado o fachada) de una forma méas comoda:
elige la capa, haz doble clic en el valor de su parametro Color y modificalo mediante
la correspondiente interfaz grafica. Explora los métodos RGB y HSV, a ver cual
te gusta més. Obviamente, utilizar un editor de texto para modificar un fichero en
formato SIF (como hicimos anteriormente) no es lo mas cémodo, pero es bueno
saber que se puede.
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. Recuerdas dénde estaba la caja de herramientas? Si no, btiscala sabiendo que se
trata de un panel llamado Toolbox. Y, en cualquier caso, busca alli la herramienta
llamada Rectangle Tool, selecciénala e introduce en el lienzo una capa rectangulo
que lo abarque todo. Para ello, tendras que arrastrar el cursor desde una esquina
hasta la opuesta. Esta capa sera el cielo, asi que dale color celeste.

Identifica la nueva capa en Layers y arrastrala hasta el fondo. Ademas, haz doble
clic en su nombre actual para cambiarlo y que pase a ser la capa Cielo.

Crea una capa Suelo adecuada. El lienzo podria quedar asi:

Utiliza File » Save para guardar el documento y luego sal de Synfig Studio.

El objetivo de este segundo ejercicio ya es crear una animacion propiamente dicha, aun-
que extremadamente sencilla. Partiremos de simple2.sif y, primero, haremos que el
sol se mueva; después, haremos despegar un cohete. Para poder tratar con animaciones,
introduciremos antes algunos conceptos nuevos, el mas importante de los cuales es la
linea de tiempo.

Vuelve a abrir simple2.sif con Synfig Studio y guardalo como simple3.sif.
Como queremos que simple3.sif sea realmente una animacion, habra que fijar
su duracion, lo que puede hacerse desde la pestaiia Time del cuadro de didlogo al
que se accede mediante Canvas » Properties... introduciendo el valor adecuado
en el campo Duration. Como con tres segundos sera suficiente, introduce exacta-
mente 3s. No olvides pulsar Enter y observa qué sucede. Independientemente de
que sigas viendo 3s o de que se haya transformado en algo similar a 72f, clica el
botén OK o bien Apply y habras fijado tres segundos de duracién.

En el ejercicio del apartado [2.1] solamente nos ha interesado el lienzo como superficie y
hemos visto que algunas propiedades de las capas (por ejemplo, Origin en el tejado de la
casa) especifican posiciones en el plano mediante los valores de dos coordenadas, a las
que habitualmente llamamos X e Y. Pero en una animacién 2D, aparte de los dos ejes
espaciales, interviene un tercero para representar la evolucion de la escena a lo largo
del tiempo, y es este eje el que responde al concepto de linea de tiempo (timeline).

Como en una pelicula de celuloide, las animaciones Synfig se componen conceptualmente
de fotogramas (frames) estaticos que crean la ilusién de movimiento al ser visualizados
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en secuencia a una cierta velocidad (pero, por supuesto, utilizar Synfig nos va a permitir
no tener que especificar individualmente cada fotograma de la animacién). Asi, una ani-
macién a 24 fotogramas por segundo compuesta por 72 fotogramas durard exactamente
tres segundos. Por eso es posible que antes la duracién 3s se transformara en 72f.

Para fijar como queremos ver valores de tiempo, ve a Edit » Preferences..., selec-
ciona la pestana Misc. y elige (HHhMMmSSs)FFf como valor del campo Timestamp.
Asi, Synfig Studio te mostrara esos valores agrupando fotogramas en segundos en
la medida de lo posible (y, en animaciones mas largas, también utilizaria minutos
e incluso horas para expresar esos valores de tiempo).

Después, vuelve a Canvas » Properties..., selecciona la pestana Time y observa
si algo ha cambiado. En cualquier caso, aprovecha para fijar algunas cosas:

Como nombre del lienzo, My First Animation.

Una velocidad de 24 fotogramas por segundo.

Deja que el tiempo empiece en el fotograma cero.

Haz que el tltimo fotograma (campo End Time) sea el correspondiente a 3s.

Esto hara que la duracion exacta se transforme en tres segundos mas un fotograma,
a causa del fotograma cero. No pasa nada. Guarda asi el documento. De hecho,
deberias acordarte de guardarlo después de cada nuevo paso que lleves a cabo.

Ahora vas a dar nombre a algunos fotogramas concretos de la animacion, a los
que denominaremos fotogramas clave (keyframes). Para déarselo al primero, busca
el panel Keyframes y observa que ya existe un fotograma clave en el instante
cero. Dale el nombre Inicio introduciéndolo en su campo Description.

Para dar nombre al tltimo fotograma, lo primero que debes hacer es moverte por
la linea de tiempo. Puedes hacerlo introduciendo 3s aqui:

@ | 3s K W« > B WM W Add Keyframe Successful ®Clamped ~ | & |%® | &

También puedes conseguirlo con el botén Seek to end (i) o haciendo clic en
el correspondiente punto de alguna representacion grafica de la linea de tiempo
(tienes una en el panel Timetrack y puedes hacer aparecer otra con Toggle timebar,
el botén representado como @ en la imagen anterior). Una vez ubicado en el altimo
fotograma, utiliza el botén derecho del raton para acceder al ment contextual del
panel Keyframes y anadir un nuevo fotograma clave (también existe un botén en
el panel para ello). Después, da el nombre Final a ese nuevo fotograma clave.

Observa que la columna Jump del panel Keyframes te permite saltar facilmente
al fotograma clave que elijas. Salta a Inicio y mueve el sol a la izquierda de la casa
y a una posicion mas baja. Salta ahora a Final. jEl sol también estd movido en
ese fotograma! Asi nunca conseguiremos una animaciéon. Deshaz para que el sol
vuelva a su posicion original.
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Para conseguir la animacion, necesitamos poder modificar diferentes fotogramas
de forma independiente. Para ello, hay que cambiar el modo de edicion, 1o que se
consigue con este botén que aparece a la derecha en la imagen del paso : (&).
Observa que, al pulsarlo, el botén cambia (pasa a ser rojo) y un borde rojo aparece
alrededor de la ventana del lienzo. Ahora si, en el modo de ediciéon para crear
animacion, salta a Inicio y mueve el sol a la izquierda de la casa y a una posicion
mas baja. Sal de ese modo de edicién (dale al hombrecito rojo para que vuelva a ser
verde) y comprueba qué has conseguido. Salta de un fotograma clave a otro (desde
Keyframes) y visita también algtin fotograma intermedio (por ejemplo, desde el
panel Timetrack). Aparte de permitirte editar Inicio y Final por separado, jSynfig
Studio ha sabido interpolar las correspondientes posiciones intermedias para el
sol!

Observa tu animaciéon con el botén Play () vy, si el sol pasa por delante de la
casa, reordena tus capas para que tal cosa no suceda: haz que pase por detras.

Obviamente, nuestro objetivo es crear animaciones que no necesiten de Synfig
Studio para ser reproducidas. Y desde File » Render... podemos conseguirlo.
Elige ffmpeg como Target, pulsa luego el botén Parameters... y, en el nuevo cua-
dro de didlogo, elige entre los posibles valores de Available Video Codecs el que
menciona al formato FLV (de Flash Video). Luego pulsa OK, cambia de .png a
.f1v la extension en Filename y pulsa Render. Si todo ha ido bien y cuentas en
el ordenador con un reproductor por defecto adecuado, podras visualizar tu ani-
macion simplemente haciendo doble clic en el nuevo fichero generado por Synfig
Studio, simple3.flv.

De nuevo desde Synfig Studio, guarda por ultima vez simple3.sif y, a conti-
nuacion, guardalo como simpled.sif. Ademas, asegurate de que cuentas con el
fichero nave.png, la imagen de una nave espacial en posicion horizontal, en la
misma carpeta que simple4.sif.

El objetivo de los ultimos pasos de este ejercicio va a ser hacer que una nave despegue
junto a la casa. La nave estara alli desde el principio de la animacion, iniciara el despe-
gue al cabo de un segundo y habra desaparecido de la escena al acabar la animacion.
Al final del ejercicio, generaras un fichero simple4.flv que serd todo lo necesario para
poder reproducir la animacion en el futuro. Pero para poder generar una version modi-
ficada de esa misma animaciéon desde Synfig Studio, necesitarias conservar no solamente
simpled.sif, sino también nave.png.

Lo primero que has de hacer es importar la imagen de la nave mediante File »
Import... y observar qué sucede. Obtienes una nueva capa nave.png que tiene
dentro otra capa con el mismo nombre. La capa interior representara para nosotros
la imagen importada y no vamos a modificarla; de la exterior, cambiale el nombre
para que sea Nave y observa que tiene un parametro Transformation, sobre el que
si vas a actuar.

En particular, para poner la nave de pie, despliega los elementos de Transformation
e introduce 90 como Angle. Deberias obtener algo asi:
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13 Para hacer la nave mas pequena conservando sus proporciones, utiliza el tirador
naranja de Nave (el de arriba a la izquierda; observards mejor que es naranja
cuando lo actives).

14 Antes de llevar la nave a la zona izquierda de la escena, vamos a hacer que todo
el movimiento del sol transcurra en la zona derecha. Para ello:

= Activa el modo de edicién para crear animacién (en adelante, por simplificar,
modo 10j0).

» Salta a Final para ver dénde acaba el sol (pero no lo toques).

= Salta a Inicio y arrastra el sol a la derecha de la casa, pero un poco a la
izquierda de la que sera su posicion final.

» Desactiva el modo rojo (pasa a modo verde).

15 Ahora, arrastra la nave a la izquierda de la casa (haciendo uso del tirador verde
de Nave, el de abajo a la derecha). Deberfas obtener algo asi:

[ )20 |-350 |-300 250 (300|350

= Inicio

= o E =

.@[ﬂﬂ W« > B BEOM O Idle (Last rendering time 0,... | ®Clamped ‘EE] ®

16 En la linea del tiempo, ubicate en 1s y crea alli un nuevo fotograma clave, uno
cuyo nombre sea Despegue.

17 En modo rojo, haz que la posicién de la nave en el fotograma Final quede por
encima de su posicion inicial, con toda la nave fuera de la escena. ;Te basta con
introducir 200 como componente Y en el elemento Offset del parametro Trans-
formation de la capa Nave? Vuelve al modo verde cuando consigas dejar la nave
fuera del encuadre.
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Reproduce la animacion dentro de Synfig Studio y arregla lo que haya podido ir
mal. Una vez arreglado, genera el correspondiente fichero simple4.f1lv con File »
Render..., guarda por tltima vez simpled.sif y sal de Synfig Studio.

Reproduce simple4.flv para comprobar que todo ha ido bien: que el sol se mueve
de forma continua durante toda la animaciéon y que la nave permanece quieta un
segundo y luego despega en vertical hasta desaparecer del encuadre.

Ya hemos visto cémo animar un objeto (el sol, una nave) de modo que vaya cambiando
su posicion a lo largo de la animacion. El movimiento puede ser uniforme a lo largo de
toda la animacion, como ocurria antes con el sol, pero también vimos que podia variar
a intervalos: la nave del ejercicio anterior estaba quieta un segundo y se movia en linea
recta dos méas. Obviamente, también podriamos fijar varios puntos intermedios en la
animacién de un objeto para hacerle describir una trayectoria en forma de linea quebra-
da, y provocar que diferentes partes de su trayecto las recorriese a diferente velocidad.
Pero, como para esto no necesitas nada mas que lo que ya sabes, vamos a introducir
ahora algo mas complicado: hacer que un objeto siga una trayectoria curva definida por
una spline. En particular, vamos a hacer que la nave del fichero nave.png recorra el
camino descrito por la capa Trayectoria del documento de Synfig trayectoria.sif.

Abre trayectoria.sif con Synfig Studio y gudrdalo como naveytrayectoria.sif.
Da a su capa Fondo un color azul oscuro. Importa nave.png y da el nombre Nave

a la mas exterior de las dos nuevas capas creadas por la importaciéon. Aparta la
nave del centro. Deberias obtener algo asi:

00

Se trata de hacer que la nave recorra la linea rosa y, ademas, de que lo haga orien-
tandose de forma adecuada, siguiendo la trayectoria (es decir, no siempre apuntan-
do hacia la derecha). Como primer paso, obligaremos a que posicion y orientacién
de la nave tengan que coincidir siempre, respectivamente, con un punto de la linea
rosa y con la tangente a la linea en ese punto. Hay que hacer exactamente esto:

» Selecciona simultaneamente las capas Nave y Trayectoria en Layers. Puedes
conseguirlo si haces clic en una y mantienes pulsada la tecla Ctrl mientras
haces clic en la segunda.

s Haz clic en un tirador de Nave.
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= Haz clic con el boton derecho sobre un punto cualquiera de la linea Trayectoria
(jno sobre un tirador!) y, en el correspondiente menui contextual, elige Link
to Spline.

Observaras que la nave se ha movido a ese punto de la linea rosa y con la orien-
tacion adecuada. Haciendo uso de su tirador verde, intenta arrastrar la nave a
diferentes lugares del lienzo y comprueba que siempre se queda pegada a la linea
rosa. No siempre al mismo punto, pero sin salirse nunca de la linea.

Técnicamente, lo que has hecho ha sido ligar dos parametros de Nave a la spline
de Trayectoria, dos elementos de Transformation:

Transfarmation 4 569962pt -94 644829pt transformation {Compaosite)
Q Offset 4569962pt -94,644829pt vector (Spline Vertex)

£ Angle -173,06° angle {Spline Tangent}

£ Skew Angle 0.a0e angle

O scale 25,584pt 25,584pt vector

Guarda naveytrayectoria.sif antes de hacer un experimento.

LY si quisiéramos que la nave siguiera la trayectoria pero siempre vertical? Por
ejemplo, porque fuera, en vez de una nave, un robot recorriendo un camino trazado
en el suelo. Pues bien, lo que tendrias que hacer en Nave seria simplemente esto:

= En el ment contextual de Angle, elegir Disconnect.

» Una vez desligados Angle y la spline, introducir 90 como valor de Angle.

Hazlo y comprueba que, entonces, aunque solamente puedes mover la nave por la
linea rosa, la nave apunta hacia arriba independientemente de en qué punto de
Trayectoria se encuentre. Despues de esta comprobacion, cierra sin guardar (File »
Close Document y Close without Saving) y vuelve a abrir naveytrayectoria.sif
(lo tendras el primero en File » Open Recent).

De momento, has fijado restricciones para el movimiento de la nave, pero todavia
no la has animado. Ahora es cuando vas a hacerlo:

= Activa el modo rojo.

Salta al instante cero de la animacién.

Lleva la nave fuera del encuadre por la izquierda.

Salta al final de la animacién, 5s.

Lleva la nave fuera del encuadre por la derecha.

Pasa al modo verde.

Utiliza el botén Play para ver el resultado.
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Antes de generar el correspondiente fichero FLV, vamos a cuidar un par de detalles
mas. El primero, que vas a hacer la trayectoria invisible. Basta para ello con que
modifiques el parametro Color de la capa Trayectoria. Simplemente, introduce cero
en su Alpha para obtener la méxima transparencia (que es lo mismo que nula
opacidad).

El segundo, que vamos a suponer que la nave se va acercando y, por lo tanto, ha
de verse cada vez mas grande. Solamente necesitas hacer la nave muy pequena en
el instante cero y muy grande en el instante final, ya que la interpolaciéon de los
tamanos intermedios correrd a cargo de Synfig. Preoctpate de hacerlo eligiendo
el modo rojo cuando sea necesario, moviéndote adecuadamente por la linea de
tiempo y sin alterar las proporciones de la nave.

Ahora ya si, genera naveytrayectoria.flv, guarda naveytrayectoria.sif y
cierra Synfig Studio. Por supuesto, comprueba también que el FLV se ve correc-
tamente.

Ya hemos visto que con Synfig Studio somos capaces de animar posiciones, orientaciones
y tamanos. Igualmente podriamos animar otras propiedades: por ejemplo, colores. Pero
el principal objetivo de este ejercicio va a ser hacer una animacién basada en un cambio
de forma. Concretamente, vamos a crear el destello de una estrella pasando de un circulo
a una cruz y, después, recuperando la forma circular inicial de la estrella.

Crea con Synfig Studio un nuevo documento de Synfig destello.sif cuya linea
de tiempo abarque del instante cero al 5s a 24 fotogramas por segundo. No olvides
ir guardando este documento después de cada paso (légicamente, en formato SIF:
uncompressed Synfig file).

También desde Canvas » Properties..., dale al lienzo el nombre Sparkle y, desde
la correspondiente pestana Image, haz que su tamano sea 960 (Width) por 540
(Height).

Con la herramienta Circle Tool, vas a crear un circulo de aproximadamente cinco
puntos de radio, primero como una capa circulo. Atencion a lo pasos:

» Haz clic en el icono de la herramienta Circle Tool.

= Busca qué panel se llama ahora, precisamente, Circle Tool y haz que, en la
fila de iconos de su campo Layer Type, solamente esté activo el que crea una
capa circulo, es decir, la fila debe quedar asi:

Layer Type

@ & C & % K

= Arrastra el cursor por el lienzo, desde donde quieras ubicar el centro del
circulo, una distancia de aproximadamente cinco puntos.

10
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4 A continuacién, acércate al circulo con la herramienta Zoom Tool, es decir, con
esa herramienta seleccionada, arrastra el cursor como si fueras a crear un pequeno
rectangulo alrededor del circulo. Veras el lienzo més o menos asi:

5 Observa en Parameters los parametros de la tinica capa tu documento. jNo hay
ninguno que permita convertir el circulo en otra forma distinta! Por lo tanto,
vamos a tener que seguir otra aproximacion:

= Selecciona nuevamente la herramienta Circle Tool.

= En el panel Circle Tool, haz que el tnico icono activo de su campo Layer
Type pase a ser el que crea una capa region.

= Crea un nuevo circulo al lado del primero, de un tamafo similar y de un
color amarillo blanquecino. Por ejemplo:

]

Para poder ver simultaneamente los distintos tiradores de tus dos circulos,
ten ambas capas seleccionadas.

Ahora si, de este segundo circulo vamos a poder cambiar su forma, introduciendo
modificaciones en su parametro Vertices, que define una spline.

6 Elimina el circulo azul desde el panel Layers (javerigua cémo!) y da a la regién
circular amarilla, como nombre de capa, Estrella.

7 Queremos convertir el circulo en cruz alejando los actuales nodos de la spline
del centro del circulo, alejandolos mucho. Pero, para conseguir el efecto desea-
do, necesitamos antes introducir nuevos nodos que permanezcan fijos durante la
transformacién. Concretamente, introduce un nuevo nodo entre cada dos nodos
originales consecutivos asi:

11
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» Utilizando la herramienta Transform Tool y con la capa Estrella selecciona-
da, haz clic con el botén derecho en un punto de la circunferencia aproxima-
damente equidistante de los dos nodos originales que estés considerando.

= En el ment contextual desplegado, elige Insert Item & Keep Shape. Apa-
recera un nuevo nodo en la spline que delimita el circulo.

Después, lleva la estrella a algin punto del cuadrante superior izquierdo, un poco
mas cerca de la correspondiente esquina que del centro del lienzo. Utiliza View »
Best Fit (y, después, View » Zoom Out una o dos veces) para comprobar que
consigues el efecto buscado.

Una vez tengas la estrella en su posicion deseada y antes de transformar el circulo
en cruz, ocupate de la linea de tiempo y crea cinco fotogramas clave como se
muestra a continuacion:

] »
v of 2512t (JMP) Inicio
v 2s12f 12f {(JMP) Empieza destello
v 3s 12f {IMP) Destello
v 3s512f  1s12f  (JMP) Acaba destello
& 55 of (JMP) Final

D @ (g

Luego salta al fotograma Destello y activa el modo rojo.

Lo de alejar del centro los nodos originales lo vas a hacer desde el panel Para-
meters. Despliega la lista Vertices y, dentro de cada vértice, al desplegarlo a su
vez, encontraras los parametros Vertex. Los cuatro nodos originales coinciden con
los que tienen un cero en alguna de sus dos coordenadas. En cada uno de estos
nodos, sustituye el valor de la coordenada no nula por otro que, respetando su
signo, aumente su magnitud a 800.

Finalmente, pasa a modo verde y reproduce la animaciéon en el propio lienzo. Y
no olvides guardar.

Con todo lo anterior ya has completado una primera version, basica, de tu animaciéon
de movimiento. Fijate en lo que has hecho. En principio, la estrella era circular en todos
los fotogramas y, en particular, también en los clave. Al cambiar su forma (en modo
rojo) en el fotograma Destello, has obligado al software a interpolar formas intermedias
entre el fotograma clave inmediato anterior, Empieza destello, y el propio Destello. Y
analogamente entre Destello y el fotograma clave inmediato posterior, Acaba destello.
Lo que toca a continuacion es realizar algunos ajustes y anadir detalles.

Anade una capa rectangular Fondo con color de cielo nocturno. Légicamente, debe
quedar detras de la estrella, no delante.

12
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14 La duracion actual del destello completo, un segundo, es demasiado larga. Modi-
fica los valores del campo Time en los fotogramas clave Empieza destello y Acaba
destello para reducir la duracion del destello a la mitad.

15 Anade una capa Nave en primer plano con la nave de nave.png moviéndose a
velocidad constante en horizontal de izquierda a derecha. Es bastante probable
que no lo consigas a la primera. El truco consiste en fijar la posicion inicial de la
nave en Inicio, fijar la final en Final (recuerda utilizar el modo rojo para conseguirlo)
y evitar que quede fijada posicion alguna en los tres fotogramas clave restantes,
ya que queremos que el software interpole para que el movimiento sea uniforme.
Puede que te encuentres con una situacion asi:

o @ 8] i @
T 7 Depth 0,000000 real
T Amount 1,000000 real
15 Blend Method Composite & integer

Q origin optopt vector

P Transformation 600,430115pt -70pt 0,00° transformation ’ ‘
¥ Canvas <Group > canvas
TC speed 1,000000 real
@ Time Offset of time
U Lock selection v & hool

Los rombos marcan puntos de referencia (waypoints) en los que Synfig Studio ha
decidido memorizar el valor de un parametro: en este caso, la posiciéon de la nave.
Pero nosotros queremos que solamente memorice sus posiciones en Inicio y Final,
y en la imagen anterior se ve un punto de referencia en un fotograma intermedio.
Habria que corregir esta situacién haciendo lo siguiente:

= Llevar el punto de referencia intermedio al fotograma clave extremo en el que
no haya punto de referencia. Esto puede hacerse con la opcién Edit del ment
contextual asociado al correspondiente rombo. En la situacion de la imagen
anterior, se trataria de introducir un cero en el correspondiente campo Time:

-

Waypoint
Value | -783,0107pt -70pt

Time ‘E ‘

Y si hubiera que llevar ese punto al final (en vez de al principio), se trataria
de introducir 5s (en vez de cero). En cualquier caso, no hay que olvidar clicar
luego el botén OK.

= Borrar nuevos puntos de referencia indeseados que hayan podido generarse

automaticamente, dejando tinicamente los extremos.

Esta situacién es la que buscamos para los puntos de referencia asociados a la
animacion de la nave:
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Name
T Z Depth
T Amount
15 Blend Method
O origin

P Transformation
W Canvas
TC speed
@ Time Offset
U1 aek selaction

Value

0,000000
1000000

Composite

Opt, 0pt

-783,010681pt,-70pt 0,00

<Group >
1,000000
of

v

© Federico Prat Villar

.

real
real

h integer
vactor
transfarmation ’
canvas
real
time

& haol

16 Una vez conseguido el efecto deseado (movimiento continuo de la nave durante los
cinco segundos de la animacion, medio segundo de destello de la estrella alrededor
de 3s), genera destello.flv y comprueba su correcta reproduccion.

17 Si no lo has hecho ya, guarda el estado final de destello.sif.

En los dos ejercicios siguientes anadiras texto y miusica a la animacién que has creado

en este ejercicio.

2.5. Texto

En este ejercicio, principalmente, vas a anadir texto a la animaciéon anterior. Y, aunque
también veremos coémo podrias animar ese texto, la version de la animacion que tendras
que guardar para el ejercicio siguiente tinicamente mostrara texto estatico. Eso si, la
fuente la vas a elegir y descargar de un sitio web especializado.

1 Desde Synfig Studio, guarda destello.sif como destellocontexto.sif para,
en este ejercicio, trabajar sobre la nueva copia, destellocontexto.sif.

2 Visita y explora la web DaFont en http://www.dafont.com/ para elegir una
fuente gratuita que te parezca apropiada para los textos de tu animacion. Busca
que tenga las siguientes caracteristicas, aparte de que te guste:

= Que esté etiquetada como 1009 Gratis.

= Que sea una fuente True Type.

Algunas caracteristicas se ven en cualquier listado de fuentes de DaFont. Aqui se
observa, por ejemplo, que la fuente Intensa Fuente es completamente gratis:

Intensa Fuente F] § de Edumorcel

INTENSA

52.693 s (186 ayer) 2 comentarics 100% Gratis

Descargar
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Para otras comprobaciones, es necesario acceder a la pagina especifica de la fuente
haciendo clic en su texto de ejemplo. Aqui puede verse que Intensa Fuente es True
Type, ya que la extension de su fichero de fuente es . ttf:

Intensa Fuente F] @ de Edumorcel

INTENSA

Ademas, més abajo en la misma pagina se muestra qué caracteres concretos inclu-
ye la fuente, aunque dificil sera (salvo error en la fuente) que falte algin caracter
que vayamos a necesitar, ya que vamos a limitarnos al inglés en los textos de
nuestras animaciones.

Utiliza el correspondiente boton Descargar de la pagina web para bajarte la fuente
al ordenador, sin olvidar tomar nota tanto del nombre de la fuente como de su
autor.

Extrae el correspondiente fichero con extension . ttf del paquete ZIP que has des-
cargado; después, situa ese fichero en la misma carpeta donde tengas el documento
Synfig destellocontexto.sif.

Vuelve a Synfig Studio, donde tienes abierto destellocontexto.sif, y selecciona
la herramienta Text Tool.

En el panel que ahora se llame Text Tool, asegiirate de que el campo Multiline Text
esté marcado (¥). Ademads, introduce en el campo Family el nombre del fichero de
fuente.

Haz clic, por ejemplo, cerca del centro del cuadrante superior derecho del lienzo.
Aparecerd un cuadro de didlogo donde introducir el texto deseado, que podra ser
de varias lineas. Puedes redimensionar ese cuadro a tu antojo para que te resulte
comodo introducir un texto analogo al siguiente:

3 Text Paragraph

Enter text here:

Animation by Federico Prat
Free font "Intensa Fuente” by Edumorce||

<Ok X Cancel

Pero, claro, con tu nombre, el de la fuente que ti hayas elegido y el de su autor.

Al pulsar OK, habras creado una nueva capa, una capa texto a la que debes llamar
Créditos y situar inmediatamente por delante de Fondo. Comprueba que realmente
hace uso de la fuente descargada y que no cometiste ningiin error al teclear el texto
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(podrias volver a acceder al cuadro de introduccion de texto Text Paragraph, que
tambien permite editar ese texto, haciendo doble clic en el valor del parametro
Text de la capa Créditos).

Elige el color que prefieras para el texto, fija también a tu gusto su tamano (con
el pardmetro Size o con el tirador naranja) y ajusta su posicién (pardmetro Origin
o tirador verde). Evita que parte del texto quede fuera del encuadre o que la nave
pueda taparlo en su movimiento. Ajusta y reproduce la animacién hasta que te
satisfaga.

Después, genera destellocontexto.flv, comprueba su correcta reproduccion y
guarda el estado final de destellocontexto.sif. Aunque a continuacion vas a
probar a animar ese texto, recuerda que el resultado de esa prueba, en principio,
no lo tienes que guardar.

Supon que tienes que animar el texto haciéndolo girar. Sin embargo, si echas un
vistazo a los parametros de la capa Créditos, veras que ninguno permite especificar
un angulo de rotacién (y no, Orientation no tiene ese significado. .. ni nos vamos
a preocupar de cudl tiene). Pero existe una solucion: meter Créditos dentro de una
capa grupo y rotar el grupo resultante. Asi pues, en el ment contextual de Créditos,
elige Group Layer, cambia el nombre por defecto del grupo (Group) por Textos y
despliega este grupo en el panel Layers para ver que contiene a Créditos. Observa,
ademas, que Textos si tiene un parametro Angle dentro de Transformation.

Plantéate ahora este objetivo concreto: hacer que el texto dé dos vueltas completas
entre el inicio de la animacién y el fotograma Empieza destello. Para ello, salta al
instante cero, entra en modo rojo, introduce como Angle de Textos 720 (es decir,
dos vueltas de diferencia con 0 en grados sexagesimales) y vuelve al modo verde.
Comprueba que solamente tienes dos puntos de referencia asociados a Angle en el
panel Timetrack: uno en Inicio y otro en Empieza destello.

Reproduce la animacion para ver qué efecto has conseguido. ;Respecto a qué
punto gira el texto? No es lo que buscamos, queremos que el texto gire alrededor
de su propio centro. Fijate en el parametro Origin de Créditos y apunta su valor
(apuntate X e Y, pero sin preocuparte de sus partes decimales). Después, pon a
cero las dos coordenadas de Origin y reproduce de nuevo. El texto ya gira alrededor
de su centro, pero en el centro del lienzo.

Para devolver el texto a la posicion que tenia en el cuadrante superior derecho,
introduce en el pardmetro Offset de la capa Textos los valores de X e Y que tienes
apuntados (puedes encontrar Offset dentro de Transformation). Reproduce para
comprobar que ya has conseguido el efecto deseado.

. Te atreves a animar la transparencia del texto? Esto es, hacer que el texto se
vaya haciendo visible a medida que gira. Se trataria de hacer con el pardmetro
Color de Créditos lo mismo que hiciste con el Angle de Textos. Del color solamente
tendrias que cambiar su componente Alpha en Inicio, introducir alli como valor un
cero.

’ 1| 0.0
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Tras comprobar cémo te ha quedado la animacién, puedes cerrar tu documento
destellocontexto.sif sin guardar los tltimos cambios o, si te gusta mucho
el efecto final que has conseguido, guardalo como destellocontextoplus.sif,
genera el correspondiente fichero FLV y, después ya si, cierra el documento que
tienes abierto en Synfig Studio.

Observa que en este ejercicio, principalmente dedicado a texto, has practicado también
una técnica importante de aplicacion muy general: utilizar una capa grupo para animar
otras capas con parametros que estas otras no poseen. Ademas, dentro de la capa grupo
podriamos tener varias capas y, asi, animarlas conjuntamente como tal grupo.

En este ultimo ejercicio guiado, vas a incorporar musica de fondo (concretamente, la
del fichero de partida monteverdi.mp3) a la animacién anterior y utilizards para ello
la aplicacion Avidemux. Antes, vas a modificar ligeramente la animacion para acreditar
al autor de esa musica.

Abre destellocontexto.sif en Synfig Studio y guarda una copia con el nuevo
nombre destellofinal.sif.

Haz doble clic en el valor del pardmetro Text de la capa Créditos y anade a ese
valor la tercera linea que se destaca a continuacion:

3 Text Paragraph

Enter text here:
Animation by Federico Prat
Free font "Intensa Fuente” by Edumorcel
Public domain music from a Monteverdi's toccata

<JOK ¥ Cancel

No olvides pulsar OK.

Ajusta tamano y posicion de Créditos hasta que el resultado vuelva a ser satisfac-
torio. Después, genera destellofinal.flv, comprueba su correcta reproduccion,
guarda el estado final de destellofinal.sif y sal de Synfig Studio.

Arranca Avidemux y utiliza File » Open para abrir destellofinal.flv.

La incorporacion de la musica debes hacerla desde Audio » Select Track. Habilita
la primera pista (Tracki [¥|Enabled) y elige .... Add audio track en su primera lista
desplegable. El fichero que debes seleccionar es monteverdi.mp3.

Pulsa el correspondiente botén de reproducciéon (@) y comprueba que video y
audio se reproducen simultaneamente. Para reproducir de nuevo, vuelve antes al
principio (©).
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Para poder generar un fichero FLV como resultado, primero has de seleccionar
FLV Muxer en Output Format.

Ahora si, ya puedes utilizar File » Save para generar el correspondiente fichero
destellosonoro.flv.

Reproduce este nuevo FLV fuera de Avidemux. ;Todo correcto?

El fichero monteverdi.mp3 es un fragmento de una pieza musical encontrada en la
web Free Music Archive (http://freemusicarchive.org/)). La pieza es una tocata de
Claudio Monteverdi interpretada por una banda del ejercito de los Estados Unidos. Se
encuentra en el dominio publico, lo que quiere decir que no esta afectada por derechos
de autor y puede utilizarse con mucha libertad. A partir del fichero MP3 descargado de
la web, se ha hecho uso de Audacity (otro programa de software libre multiplataforma)
para extraer un fragmento de cinco segundos al que también le han sido aplicados un
fade in y un fade out (es decir, el volumen sube progresivamente al principio, desde el
silencio, y al final vuelve al silencio también gradualmente). El resultado de todo este
proceso es monteverdi.mp3. Quizd no muy apropiado para acompaiar el vuelo de un
cohete por el espacio.

Vuelve a Avidemux y cambia, a modo de prueba, tu seleccién de pista sonora:
que ahora sea EduardMarcSpace.mp3. Reproduce con @ para comprobar que este
audio encaja mejor con la ambientacion espacial de la animacion.

Ademas, como este audio es mas largo que el video, podemos elegir otro fragmento
distinto de la pista para acompanar a la animacién. Por ejemplo, prueba a ver
cual seria el efecto de sincronizar el inicio del video con el segundo diez del fichero
de audio; para ello, lo que tienes que hacer es desplazar el audio diez segundos en
el sentido apropiado, asi:

Audio Output (1 track(s))
Copy - I

Configure
Filters

Shift: -10000 = ms

Se trata de que el video se sincronice con el audio como si el audio hubiera empe-
zado a reproducirse ~10000 milisegundos después (es decir, diez segundos antes)
de empezar el video.

Sal de Avidemux sin guardar.

El fichero EduardMarcSpace.mp3 es una pieza musical encontrada en la web Jamendo
(https://www.jamendo.com/) buscando miusica gratuita con la palabra space, dado el
tema de la animacion. Esta obra no se encuentra en el dominio ptublico, sino que se
distribuye con una licencia Creative Commons, concretamente con una BY-SA:
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Attribution (BY):
Se puede copiar, distribuir, mostrar, interpretar y remezclar esta obra,

siempre gue se acredite el nombre del artista.

® Significa que se puede utilizar la cancién para cualguier cosa, siempre
que se mencione el nombre del autor de la cancidn en la descripcién o
los créditos.

Share Alike (SA):
Solo se puede distribuir esta obra si la obra derivada se halla bajo la

misma licencia.
@ Significa que si se utiliza esta obra en un video para YouTube o una

remezcla, esta nueva obra se debera distribuir bajo la misma licencia
CC gue la propia cancian.

Si quieres utilizar una cancién asi en una animaciéon que luego vayas a distribuir, pue-
des hacerlo gratuitamente, pero siempre que acredites adecuadamente la autoria de
la canciéon y compartas tu animacién con la misma licencia Creative Commons. Una
acreditacion adecuada podria ser asi:

SPACE, by Eduard Marc
http://jamen.do/t/520665
Licensed under CC BY-SA 3.0

Tenlo en cuenta. No es un precio muy alto por poder acceder legalmente a la gran
cantidad y variedad de recursos gratuitos disponibles bajo licencias de este tipo, recursos
que pueden serte de mucha utilidad para tus animaciones.

3. Ejercicio final

Como ejercicio final, debes reproducir modelo.f1lv y, haciendo uso de Synfig Studio y
Avidemux, generar un fichero FLV analogo. Se trata de una animacién de un coche que
recorre una calzada sinuosa:

1
=

“/

FONT "SOUAREFONT®, BY BOU FONTS
FREE SOUND FROM HTTP://WWW.PRCOV.COM/SOUNDS/
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Presta especial atencion a lo siguiente:

Tu animacién debe tener la misma duracién y tamano que el modelo. El lienzo,
concretamente, es de 1100 x 800.

Puedes utilizar como coche el del fichero cochefl.png o bien crear uno propio
con Inkscape, mas personal. No es necesario que sea de competicion.

Puedes respetar o cambiar colores a tu gusto en toda la animacion.

Puedes utilizar el mismo sonido de fondo o buscar otro fichero MP3 (que puede
ser musica).

Para el texto, debes buscar en DaFont una fuente True Type distinta de la del
modelo.

De lo que utilices, y de tu nombre, deja adecuada constancia en el propio texto
de la animacion.

Observa que el movimiento del coche sigue una trayectoria definida por una spline.
En este caso, la spline es la propia calzada, que tiene una anchura (Outline Width)
de unos 150 puntos.

Observa que hay dos cambios de forma en la animacion: dos circulos que se convier-
ten en una efe y un uno, respectivamente. Asi, esa efe y ese uno no son caracteres
de la fuente, sino capas region.

Intenta que cada cambio de forma se inicie cuando el coche pase por encima del
correspondiente circulo.

Observa que hay texto que se mueve y que también lo hay que empieza transpa-
rente y acaba opaco.

Tanto los cambios de forma como los textos deben haber alcanzado su estado
final al menos un segundo antes de que concluya la animacién. El espectador
debe disponer de al menos un segundo con todo el texto visible y estatico.

Documento creado por Federico Prat Villar en la Universitat Jaume I de Castell6.

La licencia Creative Commons con la que se distribuye, incluidos los ficheros auxiliares
para los ejercicios, es la Attribution-ShareAlike 4.0 International, accesible aqui:

https://creativecommons.org/licenses/by-sa/4.0/

@O0
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